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EXPERIMENT 8.  Monolayer Characterization:  Contact
angles, Reflection Infrared Spectroscopy, and Ellipsometry

Objectives

1. To determine the thickness of a monolayer of alkanethiols.

2. To measure the FTIR spectrum of a monolayer of alkanethiols and see how the
spectrum relates to layer organization.

3. To see how surface chemistry relates to wettability.

Introduction

Interfaces play crucial roles in phenomena such as adhesion, friction, electroosmotic
flow, and electrode reactions.  Characterizing these interfaces is very challenging because of the
small number of molecules involved.  Typically there are between 1014 and 1015 molecules/cm2

(10-9 to 10-10 moles/cm2) in a monolayer on a surface.  Common methods to analyze surfaces
include X-ray photoelectron spectroscopy, low-energy electron diffraction, and Auger electron
spectroscopy.  Unfortunately, these techniques require expensive ultrahigh vacuum (UHV) (10-9

torr) chambers.  The need for UHV prohibits ambient analysis and also keeps these techniques
out of the undergraduate curriculum.

Fortunately, there are a few ambient techniques that are capable of probing a monolayer
of molecules.  In this laboratory, you will use external reflection infrared spectroscopy,
ellipsometry, and contact angles to investigate interfaces.  These techniques are sufficiently
sensitive to investigate an interface that is only a monolayer thick, but they also work in common
laboratory conditions.  Use of these techniques allows an introduction to the study of interfaces
at the undergraduate level.  We hope that you will find some fascination with the fact that you
can investigate a single layer of molecules and
the additional fact that a single layer of
molecules can completely change interface
properties such as wettability and electron
transfer rate constants.

The laboratory focuses on formation and
characterization of a monolayer of
octadecanethiol on gold as shown in Figure 1.
Immersion of a clean gold slide in a solution of
octadecanethiol results in the formation of a self-
assembled monolayer.  You already saw in the
cyclic voltammetry laboratory that the presence
of such a monolayer greatly reduces the rate of
electron transfer to a gold electrode.  In this lab
you will observe the formation of this monolayer
using ellipsometry and external reflection FTIR.
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Figure 0.  Formation of a Self-Assembled
Monolayer on Gold.
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You will also measure contact angles to quantify the drastic changes in wettability due to
adsorption of  a single layer of molecules.  Below we describe the specific techniques used in
this laboratory.

External Reflection FTIR Spectroscopy

You are most likely already familiar with
infrared spectroscpy of organic and inorganic
compounds in solutions or KBr pellets.  In this
lab, your organic compound is on the surface of a
gold slide.  To measure the FTIR spectrum of a
molecule on an absorbing surface such as gold,
we have to resort to reflection techniques as
shown in Figure 2 and Figure 3.  We first measure
the infrared radiation reflected from a clean gold
slide.  Next we measure the infrared spectrum
from a gold slide coated with our monolayer or
other compound of interest.  To calculate a

pseudo-absorbance spectrum, we simply use equation 1 where R is the amount of light reflected
from the coated gold at a particular wavenumber and Ro is the amount of light reflected from

clean gold at the same wavenumber.  The spectra will look similar to those measured in
transmission through KBr pellets, but a rigorous treatment of the theory of this experiment shows
that there can be differences between spectra measured in transmission and reflection.

The sensitivity of external reflection infrared spectroscopy is a strong function of the
angle of incidence (the angle between the surface normal and the incoming beem, see Figure 2).
For a reflection spectrum of a specific film, the value of absorbance due to a particular
vibrational mode reaches a maximum when using an angle of incidence of 86°.  Such high
incident angle angles are somewhat difficult to work with because they require large samples
(the cross section of the beam on the sample is large) and small errors in sample flatness yield
large errors in pseudo-absorbance values.  The instrument that you will be using employs
incident angles of 80°.  This still provides high sensitivity, but the system is easy to use.  You
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Figure 2.   Cartoon of external reflection
FTIR.  (adapted from a drawing by Dr.
Laurel Knott)
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Figure 3.  Schematic of external reflection attachment for the Mattson FTIR.  The angle of
incidence is fixed at 80º with respect to the surface normal.
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should be aware that to gain adequate sensitivity in these experiments, we employ a liquid-
nitrogen cooled mercury-cadmium telluride detector.

Now that you know a little about the experiment, let’s discuss what we can learn from
measuring the FTIR spectrum of a monolayer of octadecanethiol.  This is similar to things that
you learned when studying FTIR of organic compounds.  The self-assembled monolayer is more
or less a simple alkane on a surface.  Thus the main IR absorbance peaks that we will observe
will be due to CH2 and CH3 groups.   In fact, we will focus exclusively on the hydrocarbon
portion of the spectrum.  Peaks due to -CH2 groups are listed in Table 1 along with peak
positions for both liquid and crystalline alkanes.  Because peak positions shift to lower energy in
the crystalline state, the spectrum of the monolayer should tell us whether the monolayer is
crystalline or liquid like.  This will depend on the monolayer formation time as short formation
times should not allow the monolayer to form crystalline domains.  (That is why we have you
form one monolayer using a 1 minute immersion time and one monolayer using a 1 hr immersion
time. The 1 hr immersion should result in better organized monolayers.) The disorganized layer

Sample Asymmetric CH2 stretch Symmetric CH2 stretch
Liquid alkane 2923 cm-1 2854 cm-1

Solid alkane 2918 cm-1 2849 cm-1

should have peaks at higher wave numbers than an organized layer.  In your lab, we ask you to
determine whether the films are crystalline or liquid-like.   You should also note that there will
be peaks due to methyl groups in you FTIR spectrum.  These peaks (CH3-symmetric stretch at
2879-2883 cm-1 and CH3-asymmetric stretches at 2953-2957 cm-1 and 2961-2966 cm-1) do not
tell very much about monolayer organization because they are at the end of the chains where
there should be more freedom of motion.

There are at least two complications in reflection infrared spectroscopy.  The first is the
background.  It is very difficult to prepare a background that is free from hydrocarbon
contamination.  Our method of cleaning the surface is to use a UV/ozone cleaner to oxidize all of
the hydrocarbons on the surface.  Still even in the time between cleaning and measuring the
spectrum, there will be a small amount of contamination on the surface.  We try to minimize it
and it will be small compared with the amount of hydrocarbon in a monolayer.

The second complication is that the absorbance due to a particular mode depends on the
orientation of that mode with respect to the surface normal.  Because an electric field is
perpendicular to a metal surface, modes must have a component of their transition dipole
perpendicular to the surface in order to be active.  The absorbance of a particular mode thus
depends on the angle between the transition dipole and the surface normal.  The fact that the E-
field is perpendicular to the surface also requires us to use p-polarized light (E-vector parallel to
the plane of incidence, see Figure 2) when doing these experiments.  This complication is also an
advantage in that it allows calculation of the orientation of hydrocarbon chains on a surface.
Orientation effects cause the ratios of different peaks to be much different on a surface than in an
isotropic KBr pellet.  Although, we will not discuss this in detail because of a lack of time, you
should be aware that orientation will affect peak intensities in reflection infrared spectroscopy.
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Ellipsometry

Ellipsometry is an optical technique used for measuring thicknesses and/or refractive
indices of thin films.  In this technique we reflect polarized light from a surface and measure the
resulting changes in polarization.  Specifically, one measures the ratio, tan ψ, of the fraction of
the E-fields of p- and s-polarized light relected from the surface as well as the induced phase-
angle difference, ∆, betweeen p- and s-polarized light.   Then one uses an optical model (done by
the instrument software) to relate these polarization changes to film and substrate properties.

Figure 4 shows the optical model used to
interpret ellipsometric data.  For a single film on
a reflective substrate (such as a monolayer on
gold), there are three phases involved in the
experiment:  air, film, and metal.  Each of these
phases has a refractive index, n, and an
absorption coefficient, k.  If we know all of the
optical constants for the system and the
thickness of the film,d, we can calculate the
values of  tan ψ and ∆.  (We assume that the
base metal is optically infinitely thick, i.e. no
significant amount of light reaches the back side
of the gold due to its large absorption
coefficient.)  Conversely, if we measure tan ψ
and ∆, we can in principle calculate two of the parameters in the model, e.g., film thickness and
refractive index for one film.

The model looks daunting at first because we have to know n and k for air, the film, and
the substrate as well as air.  Fortunately, k is zero for air and most organic films as they don’t
absorb visible light.  The refractive index of air is well known to be very close to 1.  Thus, we
really only need to know four things:  film thickness and refractive index and metal refractive
index and absorption coefficient.  In any given experiment, we can only determine two
quantities.  Thus we need two measurements.  The first measurement that we make is to
determine the change in polarization due to reflection from the bare metal.  We clean a slide to
get it as contaminant free as possible and measure tan ψ and ∆ for the slide.  From this
measurement, we determine both n and k for the metal.  Next we put a film on the surface and
measure tan ψ and ∆ again.  Because we already know n and k for the metal, this measurement
allows calculation of the thickness and refractive index of the organic film.  (Usually tan ψ and ∆
are not especially sensitive to the refractive index of an ultrathin film so we estimate the
refractive index to be that of most hydrocarbons, 1.5, and simply fit the data to film thickness.)

Let’s step back for a minute and see what ellipsometry allows us to do.  We are using
light with a wavelength of around 500 nm and calculating film thickness that are on the order of
25 Å.  The whole treatment is based on Maxwell's equations which are macroscopic in nature
and yet we can measure thicknesses down to a few Å.   It's amazing that electromagnetic field
theory works well in this regime.

Air n1,k1

Gold  n3, k3

Film n2, k2

Incident
light

Reflected
light (sum)

n1=1, k1=0  n2=1.5, k2=0  
n3 and k3 are measured in a separate experiment
d-film thickness is determined by ellipsometry

d

Figure 4.  Model used to calculate the thickness
of a thin organic layer using ellipsometry.



-5-

Contact Angles

You already saw in the
electrochemistry laboratory how a
monolayer prevents electron transfer at an
electrode surface.  In this lab, we will use
contact angles to show that a monolayer of
alkanethiols completely changes the
wettability of surfaces.  In essence you
deposit an organized layer of wax that is
only one molecule thick.  By measuring the angle between a drop of solvent and a surface (see
Figure 5), we can begin to quantify the energy of the surface.  Surface energies have direct
consequences on properties such as adhesion, friction, and wettability.

To understand contact angles, one must understand surface
tension, which might also be thought of as surface free energy per
unit area.  Consider the drawing in Figure 6.  We have a soap film in
a wire frame.  Stretching the frame so as to increase the area of the
soap requires work.  The work, dW, can be described by either
equation 2 or 3.  In equation 2, work = force X distance so γ has units
of force per length and is thus thought of as a surface tension.  In
equation 3 work = energy/area x area and γ can be thought of the
differential increase in surface free energy/area (δG/δA).  This is the

way we will primarily think of γ.  Intuitively, this means that there is an energetic price to pay by
increasing the surface area of a phase.  Molecules at the surface do not have the same
neighboring interactions as molecules in the bulk and they are higher in energy than bulk
molecules.  Thus increasing surface area increases the total energy of a volume of material.

The contact angle of a drop of water
on a surface (Figure 5) is really an interplay
of the surface tension of 3 interfaces:  the
solid-liquid interface, the liquid-vapor
interface, and the solid-vapor interface.  If we
suppose that a drop is at equilibrium with the
surface and vapor, then by definition of
equilibrium, an infinitessimal change in area,
dA should produce a zero change in the
surface free energy.  Suppose a drop expands
as shown in Figure 7.  The area of the solid-
liquid interface increases by dA while the area of the solid-vapor interface decreases by dA.
Meanwhile, the area of the liquid-vapor interface increases by (cos θ)dA.  Each interface has a
specific surface tension: γlv represents the surface tension of the liquid-vapor interface, γsv

represents the surface tension of the solid-vapor interface, and γsl represents the surface tension
of the solid-liquid interface.  The sum of the free energy changes due to the infinitessimal area

θ

Figure 5.  Schematic diagram of a contact angle.
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Figure 6.  Soap film on
a wire frame.
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Figure 7.  Cross-sectional schematic drawing of an
infinitessimal expansion of a drop on a surface.
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change must be zero and is given by equation 4.  Rearranging yields the equation, often called
Young’s equation (equation 5), for a contact angle.

Young’s equation is a useful starting point for predicting contact angles, but
unfortunately, two of the three surface tensions in equation 3 are extremely hard to measure.
Values of γlv are fairly simple to measure and there are tables of these values, but values for γsv

and γsl are difficult to measure and one often resorts to a model along with contact angles to
predict these values.

The thing that I would like you to take from this class is a qualitative understanding of
contact angles.  Consider that for a drop of water to spread on a surface, it must increase its area
and hence increase its energy.  What then causes the drop to spread?  The increased surface area,
and hence increased energy, of the drop is compensated by the decreased area of the solid
surface.  Thus if the solid surface is high in energy and if the energy gained by covering the solid
surface with the liquid compensates the energy lost by expanding the drop area, the drop will
spread.  High energy surfaces such as clean metals allow water to spread.  Low energy surfaces
such as teflon will bead water because there is not a strong energy gain by covering this surface
with water.  Finally, if we use liquids with low surface tension, e.g., hydrocarbons rather than
water, contact angles will be lower because there is less of a price to pay for expanding the
surface area of the liquid.

In your lab, you will see that a clean gold surface is a high energy surface as water
spreads readily on clean gold films.  The contact angle of water with a disorganized monolayer is
high, but not as high as that of an organized monolayer.  By being organized, a monolayer
maximizes its interactions with neighbors and thus has a lower surface energy.

Procedure

Ellipsometry

Here is how to get started.  Steps 1 and 2 should be done by all groups together as they only need
to be done once.

1. Power up.  Turn on the power supply to the lamp and then ignite the lamp.  The computer
and ellipsometer electronics should be off during this procedure.  Lighting the Xenon lamp
requires a lot of power and can damage sensitive equipment.  Once the lamp is on, turn on
the ellipsometer electronics and the computer.

In ellipsometer operation, light from the Xenon lamp is columinated with the optical fiber and
then reflected from the sample at a fixed angle.  The detector contains a diffraction grating and a
diode-array detector so that 44 wavelengths of light can be analyzed simultaneously.  The
ellipsometer also contains a rotating polarizer.  The intensity of the light is recorded as the
polarizer rotates and then mathematically manipulated to give you values of ∆ and tan ψ.

0cos =+− θγγγ dAdAdA lvsvsl
(4)

lv

slsv

γ
γγθ −

=cos (5)
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2. Initiallization and Calibration.  Carefully place the silicon wafer on the sample stage and start
the WVASE program.  Go to the hardware pull down menu and select initialize.  During
initialization, software looks for the instrument configuration, the analyzer is brought up to
speed and the data acquisition is synchronized with the rotating analyzer.  Next in the
hardware menu, select align.  The ellipsometer contains a 4-quadrant detector.  To ensure
that the sample is flat (it has to be flat in order to have a precise angle of incidence), the
signal to each of the quadrants should be identical.  Adjust the tilt of the sample stage so that
the red cross is in the center of the cross-hairs.  This shows that the sample is flat.  Now go to
the hardware menu and select calibrate.  This calibration is necessary to determine the exact
positions of the input and analyzer polarizers and the relative attenuation of the ac signal
relative to the DC signal.

Note that in general when using the ellipsometer, one would also calibrate to determine the
precise angle of reflection.  This was already done for you.  Now that the ellipsometer is on, one
group will begin cleaning samples for ellipsometry, another for FTIR.  We will use two different
cleaning methods:  ozone oxidation and chemical oxidation.

1. Ellipsometry:  Clean the substrates by immersing them in fresh piranha solution for 2
minutes.  (Piranha solution consists of 3 parts 50% H202 and 1 part H2SO4.  It oxidizes
organic compounds that are on the gold surface.  It is also extremely corrosive to skin.
Wear appropriate gloves, face shield, and apron when working with this.)  Remove the
substrate and rinse it thoroughly with water.  Dry with a stream of nitrogen.

2. After cleaning the substrate, we will immediately determine its refractive index and
absorption coefficient.  To do this place the sample on the ellipsometer and align it as in
step 1.  Next go to the hardware window and select acquire ellipsometric data.  Now we
have a measured value of ∆ and tan ψ (or ψ).  From these values, we will use a model to
find n and k for the substrate.    Go to the fit window.  Click on "add-layer" and select
gold.mat.  Make sure to check that you are fitting n and k.  From the fit menu select
normal fit.  Now in the window are values of n and k for the various wavelengths.  Save
this file with a new name as it now contains your optical constants.

3. Immerse your gold substrate in a vial containing 0.001 M octadecanethiol in ethanol to
begin forming a monolayer.  In an hour, we will remove the sample.

4. Repeat steps 1 and 2 for a different substrate.  (Make sure that the optical constants are
saved under a different name.)

5. Immerse this second substrate in 0.001 M octadecanethiol in ethanol for 1 minute.
Remove it and rinse thoroughly with ethanol and water.

6. In one minute we formed a monolayer, but not likely a very ordered one.  First, let’s
measure it’s ellipsometric thickness.  Put the sample on the ellipsometer stage and align
the sample as before.  Next go to hardware and acquire ellipsometric data.  Now that you
have measured relative intensities and phases of p and s polarization, we can fit these data
to obtain the monolayer thickness.  To do this, from the fit window add the first layer,
which will be the file that you measured for this sample.  Afterward, add the generic
organic film.  This assumes that the film has a refractive index of 1.5.  Make sure that
you fit the thickness of this layer.  (Do not fit any gold parameters as you already
measured them.)  Finally, do a normal fit.  Record your thickness.  Repeat this step at 3
other spots on the sample.
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7. After one hour, remove the first substrate that you prepared and rinse with ethanol and
water.  Measure it’s thickness as you did in the previous step.  Is this thickness different
than for your 1-minute monolayer?

Infrared Characterization

Only the Mattson Research (black) and Infinity FTIR instruments will be used for this
experiment.  Both have MCT detectors and the Research instrument has a water-cooled source.
When you enter the lab, the FTIR’s will be on.  You will need a cleaned, gold substrate for a
background.  Use the following cleaning procedure.  While the substrate is cleaning, you can set
up the FTIR spectrometer for the analysis.

Gold substrate Cleaning Procedure:
Place a gold substrate in the middle of the UV/ozone cleaner tray.  Insert the tray into the

cleaner, select 10 minutes on the timer and press start.  The cleaner uses UV light to generate
ozone and oxidize organic compounds on the gold surface.  After 10 minutes, place the substrate
(gold side down in the IR) and measure it as a background as described below.

1. Log-on to the computer and select the WinFirst software.  If the Control Panel is not visible,
it can be selected from the Tools menu.

2. Load the Correct Procedure:  In the Control Panel choose Load Method… and select
“reflect.ini” and then Okay.

3. Then choose Spectrometer Set-up… and make sure that the number of scans for both the
background and the sample = 256 and that the resolution is 4 cm 

–1.  Black instrument gain =
1 and the infinity gain = 4.

4. Place the cleaned, gold substrate over the opening on the top of the reflectance attachment,
close the sample compartment, and wait a couple of minutes to allow the compartment to
purge.  From the Control Panel select Background and then hit Scan.  Save the background
to your Z: drive directory (File > SaveAs > Z:\filename).  The file will automatically be
given a .bkg extension.

5. When you are ready to collect the spectrum of a monolayer, load your background by going
to the Background Viewer under the tools menu.  All background files (*.bkg) should be
displayed.  Select your background and then Okay.  This background will automatically be
used for all subsequent sample scans.  This background will be used for both your 1 minute
monolayer and your 1 hour monolayer.

6. Place your sample over the opening in the reflectance attachment, close the sample
compartment, and wait for the compartment to purge.  From the Control Panel, select
Sample and then press Scan.

7. Save the spectrum with an appropriate name to your Z: drive (File > SaveAs > Z:\filename).
Print out your spectra and note the peak positions and peak heights.  (If your monolayers
were made more than a few minutes ago, rinse them with ethanol and dry with nitrogen
before measuring the spectra.)

8. Log off the computer when you are done but do not turn off the FTIR unless you are the last
group to use it for the day.
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Contact Angle

In this procedure, you will measure the angle between a drop of water and your monolayers.
You will recognize a parallel between the procedure and waxing your car.

1. Using the program, eject a small drop of water onto the 1 minute monolayer-coated substrate.
Take a snap shot and use the software to calculate the angle of the drop with the surface.  Do
this at 4 different spots.

2. Repeat step 1 with the 1 hour monolayer.

3. Clean a gold substrate for 10 minutes in the UV/ozone cleaner.  Measure the contact angle on
this surface at 4 different spots.

MONOLAYER CHARACTERIZATION REPORT

(1) Write an introductory paragraph including the objectives of this experiment.

(2) Determine the thickness of both the ordered and disordered films with an appropriate
standard deviation.  If one film is thicker than the other, suggest a reason why.

(3) From your IR spectra, determine which monolayer is more crystalline.  Justify your
answer.

(4) Do the contact angles on the 1-minute and 1-hour monolayer differ.  Correlate the contact
angles with your FTIR and ellipsometry results.  From your contact angles on bare gold
and the monolayers, suggest which surface has the highest energy.

(5) Write a short paragraph stating your conclusions from this lab.


